The laboratory work 8
Defining Relationships Between Dimensions and Measure Groups
Up to this point in the tutorial, each cube dimension that you defined was based on a table that was directly linked to the fact table for a measure group by a primary key to foreign key relationship. In the tasks in this topic, you link the Geography dimension to the fact table for reseller sales through the Reseller dimension, which is called a reference dimension. This enables users to dimension reseller sales by geography. For more information, see Define a Referenced Relationship and Referenced Relationship Properties.
Dimensioning Reseller Sales by Geography
1. In Solution Explorer, right-click Analysis Services Tutorial in the Cubes folder, and then click Browse.
2. Remove all hierarchies from the data pane, and then verify that the Reseller Sales-Sales Amount measure appears in the data area of the data pane. Add it to the data pane if it is not already there.
3. From the Geography dimension in the metadata pane, drag the Geographies user-defined hierarchy to the Drop Row Fields Here area of the data pane.
Notice that the Reseller Sales-Sales Amount measure is not correctly dimensioned by the Country-Region attribute members in the Regions hierarchy. The value for Reseller Sales-Sales Amount repeats for each Country-Region attribute member.
[image: Dimensioned Reseller Sales-Sales Amount measure]
4. Open Data Source View Designer for the Adventure Works DW 2012 data source view.
5. In the Diagram Organizer pane, view the relationship between the Geography table and the ResellerSales table.
Notice that there is no direct link between these tables. However, there is an indirect link between these tables through either the Reseller table or the SalesTerritory table.
6. Double-click the arrow that represents the relationship between the Geography table and the Reseller table.
In the Edit Relationship dialog box, notice that the GeographyKey column is the primary key in the Geography table and the foreign key in the Reseller table.
7. Click Cancel, switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Dimension Usage tab.
Notice that the Geography cube dimension does not currently have a relationship with either the Internet Sales measure group or the Reseller Sales measure group.
8. Click the ellipsis button (...) in the Full Name cell at the intersection of the Customer dimension and the Internet Sales measure group.
In the Define Relationship dialog box, notice that a Regular relationship is defined between the DimCustomer dimension table and the FactInternetSales measure group table based on the CustomerKey column in each of these tables. All the relationships that you have defined within this tutorial up to this point have been regular relationships.
The following image shows the Define Relationship dialog box with a regular relationship between the DimCustomer dimension table and the FactInternetSales measure group table.
[image: Define Relationship dialog box with a regular relationship]
9. Click Cancel.
10. Click the ellipsis button (...) in the unnamed cell at the intersection of the Geography dimension and the Reseller Sales measure group.
In the Define Relationship dialog box, notice that no relationship is currently defined between the Geography cube dimension and the Reseller Sales measure group. You cannot define a regular relationship because there is no direct relationship between the dimension table for the Geography dimension and the fact table for the Reseller Sales measure group.
11. In the Select relationship type list, select Referenced.
You define a referenced relationship by specifying a dimension that is directly connected to the measure group table, called an intermediate dimension, that Analysis Services can use to link the reference dimension to the fact table. You then specify the attribute that links the reference dimension to the intermediate dimension.
12. In the Intermediate dimension list, select Reseller.
The underlying table for the Geography dimension is linked to the fact table through the underlying table for the Reseller dimension.
13. In the Reference dimension attribute list, select Geography Key, and then try to select Geography Key in the Intermediate dimension attribute list.
Notice that Geography Key does not appear in the Intermediate dimension attribute list. This is because the GeographyKey column is not defined as an attribute in the Reseller dimension.
14. Click Cancel.
In the next task, you will solve this problem by defining an attribute that is based on the GeographyKey column in the Reseller dimension.
Defining the Intermediate Dimension Attribute and the Referenced Dimension Relationship
1. Open Dimension Designer for the Reseller dimension, and view the columns in the Reseller table in the Data Source View pane, and view the defined attributes in the Reseller dimension in the Attributes pane.
Notice that although GeographyKey is defined as a column in the Reseller table, no dimension attribute is defined in the Reseller dimension based on this column. Geography is defined as a dimension attribute in the Geography dimension because it is the key column that links the underlying table for that dimension to the fact table.
2. To add a Geography Key attribute to the Reseller dimension, right-click GeographyKey in the Data Source View pane, and then click New Attribute from Column.
3. In the Attributes pane, select Geography Key, and then, in the Properties window, set the AttributeHierarchyOptimizedState property to NotOptimized, the AttributeHierarchyOrdered property to False, and the AttributeHierarchyVisible property to False.
The Geography Key attribute in the Reseller dimension will only be used to link the Geography dimension to the Reseller Sales fact table. Because it will not be used for browsing, there is no value in defining this attribute hierarchy as visible. Additionally, ordering and optimizing the attribute hierarchy will only negatively affect processing performance. However, the attribute must be enabled to serve as the link between the two dimensions.
4. Switch to Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab, and then click the ellipsis button (...) at the intersection of the Reseller Sales measure group and the Geography cube dimension.
5. In the Select relationship type list, select Referenced.
6. In the Intermediate dimension list, select Reseller.
7. In the Reference dimension attribute list, select Geography Key, and then select Geography Key in the Intermediate dimension attribute list.
Notice that the Materialize check box is selected. This is the default setting for MOLAP dimensions. Materializing the dimension attribute link causes the value of the link between the fact table and the reference dimension for each row to be materialized, or stored, in the dimension's MOLAP structure during processing. This will have a minor effect on processing performance and storage requirements, but will increase query performance (sometimes significantly).
8. Click OK.
Notice that the Geography cube dimension is now linked to the Reseller Sales measure group. The icon indicates that the relationship is a referenced dimension relationship.
9. In the Dimensions list on the Dimension Usage tab, right-click Geography, and then click Rename.
10. Change the name of this cube dimension to Reseller Geography.
Because this cube dimension is now linked to the Reseller Sales measure group, users will benefit from explicitly defining its use in the cube, to avoid possible user confusion.
Successfully Dimensioning Reseller Sales by Geography
1. On the Build menu, click Deploy Analysis Services Tutorial.
2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the Reconnect button.
3. In the metadata pane, expand Reseller Geography, right-click Geographies, and then click Add to Row Area.
Notice that the Reseller Sales-Sales Amount measure is now correctly dimensioned by the Country-Region attribute of the Geographies user-defined hierarchy, as shown in the following image.
[image: Define Relationship dialog box]
Users sometimes want to be able to dimension measures by data items that are in the fact table or to query the fact table for specific additional related information, such as invoice numbers or purchase order numbers related to specific sales facts. When you define a dimension based on such a fact table item, the dimension is called a fact dimension. Fact dimensions are also known as degenerate dimensions. Fact dimensions are useful for grouping together related fact table rows, such as all the rows that are related to a particular invoice number. Although you can put this information in a separate dimension table in the relational database, creating a separate dimension table for the information provides no benefit because the dimension table would grow at the same rate as the fact table, and would just create duplicate data and unnecessary complexity.
Within Analysis Services, you can determine whether to duplicate the fact dimension data in a MOLAP dimension structure for increased query performance, or whether to define the fact dimension as a ROLAP dimension to save storage space at the expense of query performance. When you store a dimension with the MOLAP storage mode, all the dimension members are stored in the instance of Analysis Services in a highly compressed MOLAP structure, in addition to being stored in the measure group's partitions. When you store a dimension with the ROLAP storage mode, only the dimension definition is stored in the MOLAP structure-the dimension members themselves are queried from the underlying relational fact table at query time. You decide the appropriate storage mode based on how frequently the fact dimension is queried, the number of rows returned by a typical query, the performance of the query, and the processing cost. Defining a dimension as ROLAP does not require that all cubes that use the dimension also be stored with the ROLAP storage mode. The storage mode for each dimension can be configured independently.
When you define a fact dimension, you can define the relationship between the fact dimension and the measure group as a fact relationship. The following constraints apply to fact relationships:
· The granularity attribute must be the key column for the dimension, which creates a one-to-one relationship between the dimension and the facts in the fact table.
· A dimension can have a fact relationship with only a single measure group.
Note
Fact dimensions must be incrementally updated after every update to the measure group that the fact relationship references.
For more information, see Dimension Relationships, and Define a Fact Relationship and Fact Relationship Properties.
In the tasks in this topic, you add a new cube dimension based on the CustomerPONumber column in the FactInternetSales fact table. You then define the relationship between this new cube dimension and the Internet Sales measure group as a fact relationship.
Defining the Internet Sales Orders Fact Dimension
1. In Solution Explorer, right-click Dimensions, and then click New Dimension.
2. On the Welcome to the Dimension Wizard page, click Next.
3. On the Select Creation Method page, verify that the Use an existing table option is selected, and then click Next.
4. On the Specify Source Information page, verify that the Adventure Works DW 2012 data source view is selected.
5. In the Main table list, select InternetSales.
6. In the Key columns list, verify that SalesOrderNumber and SalesOrderLineNumber are listed.
7. In the Name column list, select SalesOrderLineNumber.
8. Click Next.
9. On the Select Related Tables page, clear the check boxes beside all of the tables, and then click Next.
10. On the Select Dimension Attributes page, click the check box in the header twice to clear all of the check boxes. The Sales Order Number attribute will remain selected because it is the key attribute.
11. Select the Customer PO Number attribute, and then click Next.
12. On the Completing the Wizard page, change the name to Internet Sales Order Details and then click Finish to complete the wizard.
13. On the File menu, click Save All.
14. In the Attributes pane of the Dimension Designer for the Internet Sales Order Details dimension, select Sales Order Number, and then change the Name property in the Properties window to Item Description.
15. In the NameColumn property cell, click the browse button (...). In the Name Column dialog box, select Product from the Source table list, select EnglishProductName for the Source column, and then click OK.
16. Add the Sales Order Number attribute to the dimension by dragging the SalesOrderNumber column from the InternetSales table in the Data Source View pane to the Attributes pane.
17. Change the Name property of the new Sales Order Number attribute to Order Number, and change the OrderBy property to Key.
18. In the Hierarchies pane, create an Internet Sales Orders user hierarchy that contains the Order Number and Item Description levels, in that order.
19. In the Attributes pane, select Internet Sales Order Details, and then review the value for the StorageMode property in the Properties window.
Notice that, by default, this dimension is stored as a MOLAP dimension. Although changing the storage mode to ROLAP will save processing time and storage space, it occurs at the expense of query performance. For the purposes of this tutorial, you will use MOLAP as the storage mode.
20. To add the newly created dimension to the Analysis Services Tutorial cube as a cube dimension, switch to Cube Designer. On the Cube Structure tab, right-click in the Dimensions pane and select Add Cube Dimension.
21. In the Add Cube Dimension.dialog box, select Internet Sales Order Details and then click OK.
Defining a Fact Relationship for the Fact Dimension
1. In the Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab.
Notice that the Internet Sales Order Details cube dimension is automatically configured as having a fact relationship, as shown by the unique icon.
2. Click the browse button (...) in the Item Description cell, at the intersection of the Internet Sales measure group and the Internet Sales Order Details dimension, to review the fact relationship properties.
The Define Relationship dialog box opens. Notice that you cannot configure any of the properties.
The following image shows the fact relationship properties in the Define Relationship dialog box.
[image: Define Relationship dialog box]
3. Click Cancel.
Browsing the Cube by Using the Fact Dimension
1. On the Build menu, click Deploy Analysis Services Tutorial to deploy the changes to the instance of Analysis Services and process the database.
2. After deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the Reconnect button.
3. Clear all measures and hierarchies from the data pane, and then add the Internet Sales-Sales Amount measure to the data area of the data pane.
4. In the metadata pane, expand Customer, expand Location, expand Customer Geography, expand Members, expand All Customers, expand Australia, expand Queensland, expand Brisbane, expand 4000, right-click Adam Powell, and then click Add to Filter.
Filtering to limit the sales orders returned to a single customer lets the user drill down to the underlying detail in a large fact table without suffering a significant loss in query performance.
5. Add the Internet Sales Orders user-defined hierarchy from the Internet Sales Order Details dimension to the row area of the data pane.
Notice that the sales order numbers and the corresponding Internet sales amounts for Adam Powell appear in the data pane.
The following image shows the result of the previous steps.
[image: Dimensioning of Internet Sales-Sales Amount]
When you define a dimension, typically each fact joins to one and only one dimension member, whereas a single dimension member can be associated with many different facts. For example, each customer can have many orders but each order belongs to a single customer. In relational database terminology, this is referred to as a one-to-many relationship. However, sometimes a single fact can join to multiple dimension members. In relational database terminology, this is referred to as a many-to-many relationship. For example, a customer may have multiple reasons for making a purchase, and a purchase reason can be associated with multiple purchases. A join table is used to define the sales reasons that relate to each purchase. A Sales Reason dimension constructed from such relationships would then have multiple members that relate to a single sales transaction. Many-to-many dimensions expand the dimensional model beyond the classic star schema and support complex analytics when dimensions are not directly related to a fact table.
In Analysis Services, you define a many-to-many relationship between a dimension and a measure group by specifying an intermediate fact table that is joined to the dimension table. An intermediate fact table is joined, in turn, to an intermediate dimension table to which the fact table is joined. The many-to-many relationships between the intermediate fact table and both the dimension tables in the relationship and the intermediate dimension creates the many-to-many relationships between members of the primary dimension and measures in the measure group that is specified by the relationship. In order to define a many-to-many relationship between a dimension and a measure group through an intermediate measure group, the intermediate measure group must share one or more dimensions with the original measure group.
With a many-to-many dimension, values are distinct summed, which means that they do not aggregate more than once to the All member.
Note
In order to support a many-to-many dimension relationship, a primary key-foreign key relationship must be defined in the data source view between all the tables that are involved. Otherwise, you will not be able to select the correct intermediate measure group when you establish the relationship in the Dimension Usage tab of Cube Designer.
For more information, see Dimension Relationships, and Define a Many-to-Many Relationship and Many-to-Many Relationship Properties.
In the tasks in this topic, you define the Sales Reasons dimension and the Sales Reasons measure group, and you define a many-to-many relationship between the Sales Reasons dimension and the Internet Sales measure group through the Sales Reasons measure group.
Adding Required Tables to the Data Source View
1. Open Data Source View Designer for the Adventure Works DW 2012 data source view.
2. Right-click anywhere in the Diagram Organizer pane, click New Diagram, and specify Internet Sales Order Reasons as the name for this new diagram.
3. Drag the InternetSales table to the Diagram pane from the Tables pane.
4. Right-click anywhere in the Diagram pane, and then click Add/Remove Tables.
5. In the Add/Remove Tables dialog box, add the DimSalesReason table and the FactInternetSalesReason table to the Included objects list, and then click OK.
Notice that the primary key-foreign key relationships between the tables that are involved are established automatically because those relationships are defined in the underlying relational database. If these relationships were not defined in the underlying relational database, you would have to define them in the data source view.
6. On the Format menu, point to Auto Layout, and then click Diagram.
7. In the Properties window, change the FriendlyName property of the DimSalesReason table to SalesReason, and then change the FriendlyName property of the FactInternetSalesReason table to InternetSalesReason.
8. In the Tables pane, expand InternetSalesReason (dbo.FactInternetSalesReason), click SalesOrderNumber, and then review the DataType property for this data column in the Properties window.
Notice that the data type for the SalesOrderNumber column is a string data type.
9. Review the data types for the other columns in the InternetSalesReason table.
Notice that the data types for the other two columns in this table are numeric data types.
10. In the Tables pane, right-click InternetSalesReason (dbo.FactInternetSalesReason), and then click Explore Data.
Notice that, for each line number within each order, a key value identifies the sales reason for the purchase of that line item, as shown in the following image.
[image: Key value to identify sales reason for purchases]
Defining the Intermediate Measure Group
1. Switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Cube Structure tab.
2. Right-click anywhere in the Measures pane, and then click New Measure Group. For more information, see Create Measures and Measure Groups in Multidimensional Models.
3. In the New Measure Group dialog box, select InternetSalesReason in the Select a table from the data source view list, and then click OK.
Notice that the Internet Sales Reason measure group now appears in the Measures pane.
4. Expand the Internet Sales Reason measure group.
Notice that only a single measure is defined for this new measure group, the Internet Sales Reason Count measure.
5. Select Internet Sales Reason Count and review the properties of this measure in the Properties window.
Notice that the AggregateFunction property for this measure is defined as Count instead of Sum. Analysis Services chose Count because the underlying data type is a string data type. The other two columns in the underlying fact table were not selected as measures because Analysis Services detected them as numeric keys instead of as actual measures. For more information, see Define Semiadditive Behavior.
6. In the Properties window, change the Visible property of the Internet Sales Reason Count measure to False.
This measure will only be used to join the Sales Reason dimension that you will define next to the Internet Sales measure group. Users will not browse this measure directly.
The following image shows the properties for the Internet Sales Reason Count measure.
[image: Properties for Internet Sales Reason Count measure]
Defining the Many-to-Many Dimension
1. In Solution Explorer, right-click Dimensions, and then click New Dimension.
2. On the Welcome to the Dimension Wizard page, click Next.
3. On the Select Creation Method page, verify that the Use an existing table option is selected, and then click Next.
4. On the Specify Source Information page, verify that the Adventure Works DW 2012 data source view is selected.
5. In the Main table list, select SalesReason.
6. In the Key columns list, verify that SalesReasonKey is listed.
7. In the Name column list, select SalesReasonName.
8. Click Next.
9. On the Select Dimension Attributes page, the Sales Reason Key attribute is automatically selected because it is the key attribute. Select the check box beside the Sales Reason Reason Type attribute, change its name to Sales Reason Type, and then click Next.
10. On the Completing the Wizard page, click Finish to create the Sales Reason dimension.
11. On the File menu, click Save All.
12. In the Attributes pane of the Dimension Designer for the Sales Reason dimension, select Sales Reason Key, and then change the Name property in the Properties window to Sales Reason.
13. In the Hierarchies pane of the Dimension Designer, create a Sales Reasons user hierarchy that contains the Sales Reason Type level and the Sales Reason level, in that order.
14. In the Properties window, define All Sales Reasons as the value for the AllMemberName property of the Sales Reasons hierarchy.
15. Define All Sales Reasons as the value for AttributeAllMemberName property of the Sales Reason dimension.
16. To add the newly created dimension to the Analysis Services Tutorial cube as a cube dimension, switch to Cube Designer. On the Cube Structure tab, right-click in the Dimensions pane and select Add Cube Dimension.
17. In the Add Cube Dimension dialog box, select Sales Reason and then click OK.
18. On the File menu, click Save All.
Defining the Many to Many Relationship
1. Switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Dimension Usage tab.
Notice that the Sales Reason dimension has a regular relationship defined with the Internet Sales Reason measure group, but has no relationship defined with the Internet Sales or Reseller Sales measure groups. Notice also that the Internet Sales Order Details dimension has a regular relationship defined with the Internet Sales Reason dimension, which in turn has a Fact Relationship with the Internet Sales measure group. If this dimension was not present (or another dimension with a relationship with both the Internet Sales Reason and the Internet Sales measure group were not present), you would not be able to define the many-to-many relationship.
2. Click the cell at the intersection of the Internet Sales measure group and the Sales Reason dimension and then click the browse button (...).
3. In the Define Relationship dialog box, select Many-to-Many in the Select relationship type list.
You have to define the intermediate measure group that connects the Sales Reason dimension to the Internet Sales measure group.
4. In the Intermediate measure group list, select Internet Sales Reason.
The following image shows the changes in the Define Relationship dialog box.
[image: Define Relationship dialog box]
5. Click OK.
Notice the many-to-many icon that represents the relationship between the Sales Reason dimension and the Internet Sales measure group.
Browsing the Cube and the Many-to-Many Dimension
1. On the Build menu, click Deploy Analysis Services Tutorial.
2. When deployment has successfully completed, switch to the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click Reconnect.
3. Add the Internet Sales-Sales Amount measure to the data area of the data pane.
4. Add the Sales Reasons user-defined hierarchy from the Sales Reason dimension to the row area of the data pane.
5. In the metadata pane, expand Customer, expand Location, expand Customer Geography, expand Members, expand All Customers, expand Australia, right-click Queensland, and then click Add to Filter.
6. Expand each member of the Sales Reason Type level to review the dollar values that are associated with each reason a customer in Queensland gave for their purchase of an Adventure Works product over the Internet.
Notice that the totals that are associated with each sales reason add up to more than the total sales. This is because some customers cited multiple reasons for their purchase.
The following image shows the Filter pane and Data pane of Cube Designer.
[image: Filter and Data panes of Cube Designer]
Users will want to dimension fact data at different granularity or specificity for different purposes. For example, sales data for reseller or internet sales may be recorded for each day, whereas sales quota information may only exist at the month or quarter level. In these scenarios, users will want a time dimension with a different grain or level of detail for each of these different fact tables. While you could define a new database dimension as a time dimension with this different grain, there is an easier way with Analysis Services.
By default in Analysis Services, when a dimension is used within a measure group, the grain of the data within that dimension is based on the key attribute of the dimension. For example, when a time dimension is included within a measure group and the default grain of the time dimension is daily, the default grain of that dimension within the measure group is daily. Many times this is appropriate, such as for the Internet Sales and Reseller Sales measure groups in this tutorial. However, when such a dimension is included in other types of measure groups, such as in a sales quota or budget measure group, a monthly or quarterly grain is generally more appropriate.
To specify a grain for a cube dimension other than the default grain, you modify the granularity attribute for a cube dimension as used within a particular measure group on the Dimension Usage tab of Cube Designer. When you change the grain of a dimension within a specific measure group to an attribute other than the key attribute for that dimension, you must guarantee that all other attributes in the measure group are directly or indirectly related to new granularity attribute. You do this by specifying attribute relationships between all other attributes and the attribute that is specified as the granularity attribute in the measure group. In this case, you define additional attribute relationships rather than move attribute relationships. The attribute that is specified as the granularity attribute effectively becomes the key attribute within the measure group for the remaining attributes in the dimension. If you do not specify attribute relationships appropriately, Analysis Services will not be able to aggregate values correctly, as you will see in the tasks in this topic.
For more information, see Dimension Relationships, Define a Regular Relationship and Regular Relationship Properties.
In the tasks in this topic, you add a Sales Quotas measure group and define the granularity of the Date dimension in this measure group to be monthly. You then define attribute relationships between the month attribute and other dimension attributes to ensure that Analysis Services aggregates values correctly.
Adding Tables and Defining the Sales Quotas Measure Group
1. Switch to the Adventure Works DW 2012 data source view.
2. Right-click anywhere in the Diagram Organizer pane, click New Diagram, and then name the diagram Sales Quotas.
3. Drag the Employee, Sales Territory, and Date tables from the Tables pane to the Diagram pane.
4. Add the FactSalesQuota table to the Diagram pane by right-clicking anywhere in the Diagram pane and selecting Add/Remove Tables.
Notice that the SalesTerritory table is linked to the FactSalesQuota table through the Employee table.
5. Review the columns in the FactSalesQuota table and then explore the data in this table.
Notice that the grain of the data within this table is the calendar quarter, which is the lowest level of detail in the FactSalesQuota table.
6. In Data Source View Designer, change the FriendlyName property of the FactSalesQuota table to SalesQuotas.
7. Switch to the Analysis Services Tutorial cube, and then click the Cube Structure tab.
8. Right-click anywhere in the Measures pane, click New Measure Group, click SalesQuotas in the New Measure Group dialog box, and then click OK.
The Sales Quotas measure group appears in the Measures pane. In the Dimensions pane, notice that a new Date cube dimension is also defined, based on the Date database dimension. A new time-related cube dimension is defined because Analysis Services does not know which of the existing time-related cube dimensions to relate to the DateKey column in the FactSalesQuota fact table that underlies the Sales Quotas measure group. You will change this later in another task in this topic.
9. Expand the Sales Quotas measure group.
10. In the Measures pane, select Sales Amount Quota, and then set the value for the FormatString property to Currency in the Properties window.
11. Select the Sales Quotas Count measure, and then type #,# as the value for the FormatString property in the Properties window.
12. Delete the Calendar Quarter measure from the Sales Quotas measure group.
Analysis Services detected the column that underlies the Calendar Quarter measure as a column that contains measures. However, this column and the CalendarYear column contain the values that you will use to link the Sales Quotas measure group to the Date dimension later in this topic.
13. In the Measures pane, right-click the Sales Quotas measure group, and then click New Measure.
The New Measure dialog box opens, containing the available source columns for a measure with a usage type of Sum.
14. In the New Measure dialog box, select Distinct count in the Usage list, verify that SalesQuotas is selected in the Source table list, select EmployeeKey in the Source column list, and then click OK.
Notice that the measure is created in a new measure group named Sales Quotas 1. Distinct count measures in SQL Server are created in their own measure groups to maximize processing performance.
15. Change the value for the Name property for the Employee Key Distinct Count measure to Sales Person Count, and then type #,# as the value for the FormatString property.
Browsing the Measures again in the Sales Quota Measure Group by Date
1. On the Build menu, click Deploy Analysis Services Tutorial.
2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the Reconnectbutton.
3. Click the Excel shortcut, and then click Enable.
4. In the PivotTable Field List, expand the Sales Quotas measure group, and then drag the Sales Amount Quota measure to the Values area.
5. Expand the Sales Territory dimension, and then drag the Sales Territories user-defined hierarchy to Row Labels.
Notice that the Sales Territory cube dimension is not related, directly or indirectly, to the Fact Sales Quota table, as shown in the following image.
[image: Sales Territory cube dimension]
In the next series of steps in this topic you will define a reference dimension relationship between this dimension and this fact table.
6. Move the Sales Territories user hierarchy from the Rows Labels area to the Column Labels area.
7. In the PivotTable Field list, select the Sales Territories user-defined hierarchy, and then click the down arrow to the right.
[image: Sales Territories hierarchy in the field list]
8. In the filter, click the Select All checkbox to clear all the selections, and then choose just North America.
[image: Filter pane for selecting North America]
9. In the PivotTable Field List, expand Date.
10. Drag the Date.Fiscal Date user hierarchy to Row Labels
11. On the PivotTable, click the down arrow next to Row Labels. Clear all of the years except for FY 2008.
Notice that only the July 2007 member of the Month level appears, instead of the July, 2007, August, 2007, and September, 2007 members of Month level, and that only the July 1, 2007 member of the Date level appears, instead of all 31 days. This behavior occurs because the grain of the data in the fact table is at the quarter level and the grain of the Date dimension is the daily level. You will change this behavior in the next task in this topic.
Notice also that the Sales Amount Quota value for the month and day levels is the same value as for the quarter level, $13,733,000.00. This is because the lowest level of data in the Sales Quotas measure group is at the quarter level. You will change this behavior in Lesson 6.
The following image shows the values for Sales Amount Quota.
[image: Values for Sales Amount Quota]
Defining Dimension Usage Properties for the Sales Quotas Measure Group
1. Open Dimension Designer for the Employee dimension, right-click SalesTerritoryKey in the Data Source View pane, and then click New Attribute from Column.
2. In the Attributes pane, select SalesTerritoryKey, and then set the AttributeHierarchyVisible property to False in the Properties window, set the AttributeHierarchyOptimizedState property to NotOptimized, and set the AttributeHierarchyOrdered property to False.
This attribute is required to link the Sales Territory dimension to the Sales Quotas and Sales Quotas 1 measure groups as a referenced dimension.
3. In Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab, and then review the dimension usage within the Sales Quotas and Sales Quotas 1 measure groups.
Notice that the Employee and Date cube dimensions are linked to the Sales Quotasand Sales Quotas 1 measure groups through regular relationships. Notice also that the Sales Territory cube dimension is not linked to either of these measure groups.
4. Click the cell at the intersection of the Sales Territory dimension and the Sales Quotas measure group and then click the browse button (...). The Define Relationship dialog box opens.
5. In the Select relationship type list, select Referenced.
6. In the Intermediate dimension list, select Employee.
7. In the Reference dimension attribute list, select Sales Territory Region.
8. In the Intermediate dimension attribute list, select Sales Territory Key. (The key column for the Sales Territory Region attribute is the SalesTerritoryKey column.)
9. Verify that the Materialize check box is selected.
10. Click OK.
11. Click the cell at the intersection of the Sales Territory dimension and the Sales Quotas 1 measure group and then click the browse button (...). The Define Relationship dialog box opens.
12. In the Select relationship type list, select Referenced.
13. In the Intermediate dimension list, select Employee.
14. In the Reference dimension attribute list, select Sales Territory Region.
15. In the Intermediate dimension attribute list, select Sales Territory Key. (The key column for the Sales Territory Region attribute is the SalesTerritoryKey column.)
16. Verify that the Materialize check box is selected.
17. Click OK.
18. Delete the Date cube dimension.
Instead of having four time-related cube dimensions, you will use the Order Date cube dimension in the Sales Quotas measure group as the date against which sales quotas will be dimensioned. You will also use this cube dimension as the primary date dimension in the cube.
19. In the Dimensions list, rename the Order Date cube dimension to Date.
Renaming the Order Date cube dimension to Date makes it easier for users to understand its role as the primary date dimension in this cube.
20. Click the browse button (...) in the cell at the intersection of the Sales Quotas measure group and the Date dimension.
21. In the Define Relationship dialog box, select Regular in the Select relationship type list.
22. In the Granularity attribute list, select Calendar Quarter.
Notice that a warning appears to notify you that because you have selected a non-key attribute as the granularity attribute, you must make sure that all other attributes are directly or indirectly related to the granularity attribute by specifying them as member properties.
23. In the Relationship area of the Define Relationship dialog box, link the CalendarYear and CalendarQuarter dimension columns from the table that underlies the Date cube dimension to the CalendarYear and CalendarQuarter columns in the table that underlies the Sales Quota measure group, and then click OK.
Note
The Calendar Quarter is defined as the granularity attribute for the Date cube dimension in the Sales Quotas measure group, but the Date attribute continues to be the granularity attribute for the Internet Sales and Reseller Sales measure groups.
24. Repeat the previous four steps for the Sales Quotas 1 measure group.
Defining Attribute Relationships Between the Calendar Quarter Attribute and the Other Dimension Attributes in the Date Dimension
1. Switch to Dimension Designer for the Date dimension, and then click the Attribute Relationships tab.
Notice that although Calendar Year is linked to Calendar Quarter through the Calendar Semester attribute, the fiscal calendar attributes are linked only to one another; they are not linked to the Calendar Quarter attribute and therefore will not aggregate correctly in the Sales Quotas measure group.
2. In the diagram, right-click the Calendar Quarter attribute and then select New Attribute Relationship.
3. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Quarter. Set the Related Attribute to Fiscal Quarter.
4. Click OK.
Notice that a warning message appears stating that the Date dimension contains one or more redundant attribute relationships that may prevent data from being aggregated when a non-key attribute is used as a granularity attribute.
5. Delete the attribute relationship between the Month Name attribute and the Fiscal Quarter attribute.
6. On the File menu, click Save All.
Browsing the Measures in the Sales Quota Measure Group by Date
1. On the Build menu, click Deploy Analysis Services Tutorial.
2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click Reconnect.
3. Click the Excel shortcut, and then click Enable.
4. Drag the Sales Amount Quota measure to the Values area.
5. Drag the Sales Territories user hierarchy to the Column Labels, and then filter on North America.
6. Drag the Date.FiscalDate user hierarchy to the Row Labels, and then click the down arrow next to Row Labels on the PivotTable, and clear all check boxes other than FY 2008, to display only fiscal year 2008.
7. Click OK.
8. Expand FY 2008, expand H1 FY 2008, and then expand Q1 FY 2008.
The following image shows a PivotTable for the Analysis Services Tutorial cube, with the Sales Quota measure group dimensioned correctly.
Notice that each member of the fiscal quarter level has the same value as the quarter level. Using Q1 FY 2008 as an example, the quota of $9,180,000.00 for Q1 FY 2008 is also the value for each of its members. This behavior occurs because the grain of the data in the fact table is at the quarter level and the grain of the Date dimension is also at the quarter level. In Lesson 6, you will learn how to allocate the quarterly amount proportionally to each month.
[image: Sales Quota measure group dimensioned correctly]
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